MEMORANDUM

To: All PTAB Users

From: James Donald Smith
Chief Administrative Patent Judge

Subject: Standard Operating Procedure 4 (Revision 5.0)

The attached document supersedes the Patent Trial and Appeal Board’s Standard Operating Procedure 4 (Revision 4), dated September 16, 2012.

This is a complete revision of the previous SOP and should be read in its entirety. A summary of the major changes are listed below:

The SOP now includes processing of documents issued in AIA proceedings, as required by 35 U.S.C. § 6(a) (as amended by the Leahy-Smith America Invents Act).

Appendix A incorporates the former “SOP4 working document.”

The top margin on the front page is now one inch, as this eases formatting problems and allows text of the opinion to start on the front page.

This revision is effective May 30, 2014.

Attachment:
Standard Operating Procedure 4
PATENT TRIAL AND APPEAL BOARD
STANDARD OPERATING PROCEDURE 4 (Revision 5.0)
STANDARDS FOR OPINIONS IN BOARD DECISIONS

This document sets standards for the format of opinions in decisions by the Patent Trial and Appeal Board (Board). Standards are set with the following objectives in mind:

(1) to ensure that opinions look professional;
(2) to place the focus on the substantive basis for opinions rather than on selecting a format; and
(3) to maintain high quality.

Having standards in place also increases efficiency by providing guidance to both Administrative Patent Judges (APJ) and administrative staff in opinion preparation. The following directives are set forth to accomplish these objectives.

This Standard Operating Procedure (SOP) creates internal norms for the administration of the Board. It does not create any legally enforceable rights.
I. WORKING RELATIONSHIPS AND RESPONSIBILITIES

Under the guidance of the supervisory paralegal, the paralegals on each support team are expected to review draft documents for proper citation form, grammar, style, punctuation, and reference to precedents and the evidentiary record. Appendix A provides further details and some specific examples for the application of the standards set out below. Appendix B provides examples for standard first page formatting of opinions. Appendix C provides helpful hints for using tools available in Microsoft Word to automate consistency with the standards set forth in this document.

II. STANDARDIZATION

A. Formatting

1. Opinions are formatted in Microsoft Word; please set the following initial codes and settings in Microsoft Word:
   a. Justification – LEFT
   b. Widow-Orphan Protection – ON
   c. Font – Times New Roman 14
   d. Line spacing – 1.5 (including spacing between paragraphs)
   e. Margins – 1.25 inch on each side, 1.0 inch on top and bottom (MS Word defaults), including the first page.
   f. Footnotes, headers, footers, case captions, and mailing addresses – same size font as text on page, single-spaced.

---

1 This formatting has been selected based on multiple criteria, e.g., readability, reduced size (number of pages) in a resulting paper decision, reduced size (kilobytes) in a resulting electronic file, and conventional usage.
g. Page numbers are located at the bottom, center of each page of the opinion, except for the first page (no page numbering on the first page).

h. A header is placed on the front page of AIA and Interference papers including the email, telephone number, paper number, and date. See Appendix B.

i. On the first page of the decision, triple space before the title, e.g., "DECISION ON APPEAL."

j. A header shall be placed at the left side of the second and each subsequent page of opinions:

   Appeal xxx-xxxxxxx
   Application xx/xxx,xxx

   or

   Appeal xxx-xxxxxxx
   Patent x,xxx,xxx
   Reexamination Control xx/xxx,xxx

   or

   IPR xxx-xxxxxxx
   Patent x,xxx,xxx

   or

   CBM xxx-xxxxxxx
   Patent x,xxx,xxx

   or

   Interference No. xxx,xxx
   [Party] v [Party]
2. General formatting for the body of an opinion follows:

a) Use "keep with next" to keep headings on the same page with the text underneath (click on the paragraph menu and then the "line and page breaks" tab).

b) Use "CTRL," "SHIFT" and "SPACE" at the same time to create a "hard space" which will keep the text on both sides of the space together on the same line of text. This prevents a hanging $ symbol or bracket at the end of a line, etc.

c) Use "CTRL," "SHIFT" and "DASH" at the same time to create a "hard dash" which will keep the text on both sides of the dash together on the same line of text.

d) Use proper ellipses: use "..." [periods with spaces between], not "...". Bluebook Rule 5.3.

e) When using a dash in the middle of a sentence, use an "em dash" not an "en dash."

1. an "en dash" is roughly the width of an N, a little longer than a regular hyphen, and is used instead of "to" for example 2001–2002. Use "CTRL" and - (minus sign on key pad).

2. an "em dash" is roughly the width of an M and may be used to set off phrases (see Strunk & White Rule 8) here is an em dash—formed by typing the first word, then typing two hyphens in a row and then typing the next word—Word will automatically turn the two hyphens into an em dash. Use "CTRL" "ALT" and - (minus sign on key pad).

f) Do not use bullet points in the body of an opinion.
g) Use two spaces after a period at the end of a sentence or citation.

B. Emphasis

Italic or bold type font is acceptable for emphasis.

Capitalization and centering are used for every letter of the title and major headings, without further emphasis, e.g., “DECISION ON APPEAL,” “ANALYSIS,” or “CONCLUSION.” The title and/or major heading are not underlined, italicized, or bolded.

Capitalization, underlining, and centering are used for every letter of a word describing the outcome at the end of an opinion, without further emphasis, e.g., “AFFIRMED.”

C. Citation

1. Legal and Technical Authority

The authoritative guide for citations is the most recent edition of The Bluebook: A Uniform System of Citation. (See Appendix A, item 15)

2. Patents and Published Applications

Patents and published applications are identified by at least the surname of the first listed inventor, number, country code, and issue or publication date prior to any shorthand reference to the document, such as “Jones.” The format and placement of initial reference identification is left to the discretion of the authoring APJ.

In pre-AIA applications, for U.S. patents and published applications that qualify as prior art under 35 U.S.C. § 102(e) rather than § 102(b), a § 102(e) filing date is not required unless the date is relevant to an issue in the case.
3. Examples are provided in Appendix A.

D. Grammar / Style

William Strunk, Jr. & E. B. White, Elements of Style (Longman 4\textsuperscript{th} ed. 1999); William Sabin, Gregg Reference Manual (Tribute ed., 11\textsuperscript{th} ed. McGraw-Hill Co. 2011), and Lynn Quitman Troyka & Douglas Hess, Quick Access Reference for Writers (Prentice Hall 5\textsuperscript{th} ed. 2007 (or 6\textsuperscript{th} ed. 2010)), are the recommended reference guides for assistance with grammar usage when writing opinions. For a list of other acceptable reference sources, please consult Appendix A, item 30.

E. Separate Opinions

Separate opinions (dissents and concurrences) shall be formatted like majority opinions as described herein. Each separate opinion shall begin on a new page and the pages of such opinion shall be separately numbered at the bottom center of each page of the opinion, except for the first page (no page numbering on the first page) but succeeding pages would be numbered (2, 3, 4, etc.).

F. Quality Oversight

1. APJs are encouraged to interact with the Paralegal in order to successfully process decisions.

2. APJs are encouraged to provide positive and/or negative feedback to the Supervisory Paralegal Specialist regarding the processing of any draft decision in an effort to ultimately reach and/or achieve higher levels of excellence in decision processing.
3. When an issue or question arises concerning a particular formatting item, citation, or usage of grammar, the matter shall be resolved by following SOP4 and Appendix A.

G. Standard First and Last Pages of an Opinion

Examples of a standard first page for opinions are set forth in the attached Appendix B, which includes examples of pages from: an opinion in a decision on appeal in an ex parte regular application; an opinion in a decision on appeal in an ex parte reissue application; an opinion in a decision on appeal in an ex parte reexamination proceeding; an opinion in a decision on appeal in an inter partes reexamination proceeding; a decision in an interference proceeding; and a decision in an AIA proceeding.

When appropriate use one of the following titles:

DECISION
DECISION ON APPEAL
DECISION ON REQUEST FOR REHEARING
ORDER REMANDING TO THE EXAMINER
ORDER REQUIRING ADDITIONAL BRIEFING BY APPELLANT
ORDER DISMISSING APPEAL

Other appropriate titles for AIA decisions:

DECISION
FINAL WRITTEN DECISION
ERRATUM
ORDER
SCHEDULING ORDER
Examples of a first page for a decision containing a majority opinion and another opinion (e.g., concurring or dissenting), and a standard last page for opinions are set forth in the Appendix B.

III. SECTION 508 COMPLIANCE

Section 508 of the U.S. Rehabilitation Act requires that all Federal agencies' electronic and information technology be accessible to people with disabilities. This requirement applies to all final Board opinions that are posted on the eFOIA section of the USPTO's web page and all Board opinions made available to the public in PRPS.

Compliance with § 508 requires that text-equivalent content be associated with all non-text elements (images or figures) within a document to provide equivalent access. Associating text equivalent content with an image or figure in a document must be done when the document is created.

To meet this requirement, the Board has standardized the format by which images and figures are identified and described in the text of the document during its creation. The format requires the following, which are illustrated in the example below:

1. A statement identifying the image/figure must immediately precede the image; and
2. A statement describing the image/figure must immediately follow after the image. Example:

Figure 2 is reproduced below:
Figure 2 depicts an automobile anti-skid device.

Ensuring that Board opinions comply with § 508 is the responsibility of the paralegal support team member. As a result, APJs must make sure that opinions are processed through a support team member for verification that the opinion is § 508 compliant.

Additional resources regarding § 508 compliance can be found at:

http://ptoweb.uspto.gov/wmb/s508/s508home.html
http://www.section508.gov/
APPENDIX A
Formatting

Capitalization

Abbreviations
2. Omit periods in abbreviations of four or more words (e.g., PTAB, BPAI, MPEP).

3. Use the symbol "§" as an abbreviation for the word "section," and "§§" for "sections" throughout the text. However, spell out ("Section") if used at the beginning of a sentence. R3.3 (pp. 69-70); R6.2(c) (pp. 82).

4. Use the symbol "¶" as an abbreviation for the word "paragraph," and use "¶¶" for "paragraphs" throughout the text. However, spell out ("Paragraph") if used at the beginning of a sentence. R3.3 (pp. 69-70); R6.2(c) (pp. 82).

5. Spell out the word "column" within a sentence, but abbreviate as "col." when used in a citation. Bluebook Table (hereafter "T") 16.
   (Ex. 1001, col. 1, ll. 2-3 or Ex. 1001, 1:2-3).
6. Spell out the word “line” or “lines” within a sentence, but abbreviate as “l.” or “ll.” in a citation. T16.
   (Ex. 1001, col. 1, ll. 2-3 or Ex. 1001, 1:2-3).

7. Other abbreviations used in Board decisions — the following abbreviations represent words commonly used in Board decisions. Most of these abbreviations are taken from the Bluebook.

   I. Court Documents (The Bluebook Bluepages Table (hereafter “BT”) I)

   A. The following list includes words that are commonly abbreviated in Board decisions, including words that should not be abbreviated.

   Affidavit Aff.
   Answer Answer
   Appeal See Brief
   Appendix App.
   Attorney [s] Att’y [s]
   Brief Br.

   If the decision contains only an Appeal Brief, then it should be identified as Br. However, if the decision contains both an Appeal and Reply Brief, they are identified as Appeal Br. and Reply Br., respectively.

   Declaration Decl.
   Exhibit Ex.
   Hearing Hr’g
<table>
<thead>
<tr>
<th>Word</th>
<th>Abbreviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reconsideration</td>
<td>Recons.</td>
</tr>
<tr>
<td>Rehearing</td>
<td>Reh’g</td>
</tr>
<tr>
<td>Reply</td>
<td>Reply</td>
</tr>
<tr>
<td>Request</td>
<td>Req.</td>
</tr>
<tr>
<td>Specification</td>
<td>Spec.</td>
</tr>
<tr>
<td>Transcript</td>
<td>Tr.</td>
</tr>
</tbody>
</table>

B. Words of more than six letters not appearing in this table may also be abbreviated **if the abbreviation selected is unambiguous** (emphasis added).

### II. Case Names (T6)

- **Associate**
- **Board**
- **Commission**
- **Commissioner**
- **Committee**
- **Company**
- **Corporation**
- **Department**
- **Incorporated**
- **Industr[y, ies, ial]**
- **International**
- **Laboratory**

- **Assoc.**
- **Bd.**
- **Comm’n**
- **Comm’r**
- **Comm.**
- **Co.**
- **Corp.**
- **Dep’t**
- **Inc.**
- **Indus.**
- **Int’l**
- **Lab.**

### III. Subdivisions (T16)

- **Column [s]**
- **Example [s]**

- **col., cols.**
- **ex., exs.**
Figure[s]                      Fig., Figs.\textsuperscript{1}
Line[s]                       I., II.
Number[s]                     no., nos.
Rule                           R.
Volume[s]                     vol., vols.

\textbf{IV. Abbreviations for Ex Parte Decisions:}

Examiner's Answer             Answer or Ans.
Appeal Brief                  Appeal Br. or App. Br.
Reply Brief                   Reply Br.
Non-Final Office Action       Non-Final Act. or Non-Final
Final Office Action           Final Action or Final Act.

We note that the above abbreviations are not specifically provided for by the Bluebook, however, they do appear in decisions by the Board.

\textbf{V. Abbreviations for AIA Decisions:}\textsuperscript{2}

Petition                      Pet.
Preliminary Response          Prelim. Resp.
Motion\textsuperscript{1} (to amend or other) (optional abbreviated party name) Mot.
Patent Owner’s Response to    PO Resp.
   Petition

\textsuperscript{1} We note that Bluebook has "fig." in lower case, we have found that it looks better when "Fig." is capitalized, especially in a string citation.

\textsuperscript{2} A pinpoint citation to a particular page of the paper may be included after the abbreviation. Note, "at" should not be used to introduce the pinpoint citation. See Pet. 4; PO Resp. 8-10; Pet. Reply 15.
<table>
<thead>
<tr>
<th>Document Type</th>
<th>Abbreviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Petitioner’s reply to patent owner response</td>
<td>Pet. Reply</td>
</tr>
<tr>
<td>Opposition(^1) (to motion to amend or other)</td>
<td>Opp.</td>
</tr>
<tr>
<td>Reply(^3) (to opposition to motion to amend or other)</td>
<td>Reply</td>
</tr>
<tr>
<td>Response to observation</td>
<td>Resp.</td>
</tr>
<tr>
<td>Exhibit</td>
<td>Ex. [number] (optional description)</td>
</tr>
<tr>
<td>Exhibit List</td>
<td>[PO or Pet.] Ex. List</td>
</tr>
<tr>
<td>Declaration</td>
<td>Decl. ##:##-##:## (can be used as a short form after initial citation to the Exhibit)</td>
</tr>
<tr>
<td>Transcript</td>
<td>Tr. ## (can be used as a short form after initial citation to the Exhibit)</td>
</tr>
<tr>
<td>Corrected/Renewed version of any paper</td>
<td>Corrected/Renewed Paper name</td>
</tr>
<tr>
<td>Miscellaneous Documents (e.g. Mandatory Notice, Notice of Filing Date, Related Matters, Power of Attorney, etc. . . .)</td>
<td>(optional) Paper Name in PRPS + (required) (Paper #xyz)</td>
</tr>
<tr>
<td>Decisions</td>
<td>Dec. on Paper Name in PRPS (e.g. Dcc. on Mot.) with optional (Paper #xyz) for clarity</td>
</tr>
</tbody>
</table>

\(^1\) Note – if it is not readily apparent to which motion this refers, i.e., several motions have been filed, any citation may add an explanatory parenthetical (Paper #xyz) – referencing the document # in PRPS.
Orders
Order Paper Name in PRPS with optional (Paper #xyz) for clarity

Request for Rehearing
Req. Reh’g

Final Written Decision
Final Dec.

VI. Other Abbreviations

The following abbreviations are also used by the Board:

- Patent Trial and Appeal Board
  - PTAB
- Board of Patent Appeals and Interferences
  - BPAI
- Board of Patent Appeals (before 1985)
  - Bd. App.
- Board of Patent Interferences (before 1985)
  - Bd. Pat. Int.
- Decisions of the Commissioner of Patents
  - Dec. Comm’r Pat.
- United States Code
  - U.S.C.
- Code of Federal Regulations
  - C.F.R.
- Court of Customs and Patent Appeals
  - CCPA
- Federal Reporter
  - F., F.2d, F.3d (1st, 2d, and 3d series)
- Federal Appendix
  - F. App’x
- Federal Register
- Federal Rules of Civil Procedure
  - Fed. R. Civ. P.
- Federal Rules of Evidence
  - Fed. R. Evid.
- Federal Supplement
  - F. Supp.
  - MPEP
- Official Gazette
  - Off. Gaz. [or O.G.]
- United States Patent Quarterly
  - USPQ
Use the short cite "*id.*" sparingly and only in close proximity to the specific authority. Also, if a different pinpoint citation to a page number is included after the "*id.*" use "at," but do not use "at" when the pinpoint citation is to a section or paragraph. For example, *id. at* 14, but *id. §* 1981. R4.1 (pp. 72-73; Note: the period at the end of *id.* is always italicized).

*Italicization*

8. The Bluebook provides specific guidance regarding italicization of foreign words within a sentence (in contrast to a word in a citation). The Bluebook provides a list of examples of words that are not italicized. R7 (p. 83). Italicize a foreign word if it is not in this list. Accordingly, do not italicize the phrases "prima facie," "en banc," or "res judicata." Additionally, italicize "e.g." and "i.e." only when part of a signal. R7(b) (p. 83). Note: "*inter partes*" is italicized.

9. Italicize signals used in citations. Some examples of signals are shown in the following cites, *see Ex parte Lee,* 31 USPQ2d 1105 (BPAI 1993); *e.g., In re Vaeck,* 947 F.2d 488 (Fed. Cir. 1991). R1.2 (pp. 54-55).

*Claim Formatting*

10. The formatting of claims is ultimately discretionary with the API. Preferably, double-indent and single space claims with 1.5 spaces between claims.

*Quotations*

11. Follow the Bluebook for quotations. Quotations of 49 words or less should be enclosed in quotation marks but not otherwise set off from the rest of the text. Quotation marks around material quoted inside another quote
should appear as single marks within the quotation. R5.2(b) (p. 77).
Example: “firm resolve to insure that the CIA’s ‘power that flows from
money and stealth’ could not be turned . . . .”

Block Quotations
12. Follow the Bluebook for block quotations. Quotations of 50 words or
more should be in block form, and should be indented on the left and right
without quotation marks, and quotation marks should appear as they do in
the original. R5.1(a) (p. 76-77).

Citation of judicial/administrative opinions (T1).
13. Whenever a decision is cited in full, give its entire subsequent history,
but omit denials of certiorari or denials of similar discretionary appeals,
UNLESS the decision is less than two years old or the denial is particularly
relevant. R10.7 (pp. 101-103).

14. Do not parallel cite to other sources. A parallel cite references the
same case in two or more sources. Example: Do not cite as
KSR International Co. v. Teleflex Inc. (KSR), 550 U.S. 398. 82 USPQ2d
1385 (2007); cite as KSR International Co. v. Teleflex Inc. (KSR), 550 U.S.
398 (2007).

15. In order of priority, use the following sources for each of the listed
decisions:
   a) Supreme Court citations are to the United States Reports (U.S.), or
      West’s Supreme Court Reports (S. Ct.)
b) Court of appeals citations are to the Federal Reporter (F., F.2d or F.3d) or the Federal Appendix (Fed. App.), when available. When not available, citations are to the United States Patent Quarterly.


e) Board decisions are to the United States Patent Quarterly, when available. When not available, citations are to the slip opinions available at PTAB Reading Room. For example, *Ex parte Giles*, Appeal 2011-012860 (PTAB Feb. 24, 2014); *Gillman v. Stoneagle Servs., Inc.*, Case CBM2013-00047 (PTAB Feb. 18, 2014). See R10.8.1 (p. 104). To provide a pinpoint citation to a particular page, use the following format. *Ex parte Giles*, Appeal 2011-012860, slip op. at 7 (PTAB Feb. 24, 2014); *Gillman v. Stoneagle Servs., Inc.*, Case CBM2013-00047, slip op. at 9 (PTAB Feb. 18, 2014). You also may provide an explanatory parenthetical with the url link to the opinion:

http://e-foia.uspto.gov/Foia/PTABReadingRoom.jsp

16. In citations to Board decisions, abbreviate “Patent Trial and Appeal Board” as “PTAB.” For citation to Board decisions before September 16, 2012, when the Board was known as “Board of Patent Appeals & Interferences,” abbreviate as “BPAI” rather than “Bd. of Pat. App. & Int.”
For citation to Board decisions before February 8, 1985, when the Board was known as the Board of Patent Appeals, and the Board of Patent Interferences, abbreviate as “Bd. App.” and “Bd. Pat. Int.,” respectively.

17. Additional guidance on citation format not addressed specifically in the Bluebook may be found in Federal Circuit decisions.

Citation of references in Board decision

18. The use of a table for the citation of references is at the discretion of the APJ.

When a table is used, we recommend the following format:

The prior art relied upon by the Examiner in rejecting the claims on appeal:

<table>
<thead>
<tr>
<th>Author(s)</th>
<th>Patent Number</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>(hereinafter “Lencoski”)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Waechter</td>
<td>US 6,113,525</td>
<td>Sep. 5, 2000</td>
</tr>
<tr>
<td>Coley et al.</td>
<td>US 2005/0273436 A1</td>
<td>Dec. 8, 2005</td>
</tr>
<tr>
<td>(hereinafter “Coley”)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>O’Brien</td>
<td>US 7,000,000 B1</td>
<td>Feb. 14, 2006</td>
</tr>
<tr>
<td>Carlino et al.</td>
<td>WO 00/39666</td>
<td>Jul. 6, 2000</td>
</tr>
<tr>
<td>(hereinafter “Carlino”)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>


Michael R. Isley et al., *Recent Advances in Intraoperative Neuromonitoring of Spinal Cord Function: Pedicle Screw*
Stimulation Techniques, 37 Am. JU. Electroneurodiagnostic Tech. 93 (1997).


As can be seen in the above example, list first the U.S. references, usually in ascending date order, followed by the foreign references, then the journal, book and/or electronic references.

19. In pre-AIA applications, for U.S. patents and published applications that qualify as prior art under 35 U.S.C. § 102(e) rather than § 102(b), a § 102(e) filing date is not required unless the date is relevant to an issue in the case.

20. For non-patent literature (NPL) documents follow Bluebook citation form. See R15 (pp. 138-146); R16 (pp. 147-158).

21. Citing to a patent application paragraph, do not include brackets (e.g., The patent application describes elephants. Ex. 1002 ¶ 16; Not: Ex. 1002 ¶ [0016] or Ex. 1002 ¶ 0016. There is no comma between the exhibit number and the paragraph symbol. See R 3.3 (p. 69-70)
22. Use the Exhibit number to refer to a reference in a citation sentence (e.g., The patent describes elephants, Ex. 1001, col. 1, ll. 2-7 or Ex. 1001, 1:2-7.)

23. The Kind Code is the two (2) digit code that follows the publication number of a U.S. patent or application (e.g., 9,876,564 B1). The Kind Code range is from A to C3 (see explanation and examples below). If a cited publication includes a Kind Code that is not included by the APJ in the decision, the Paralegal should add it to the citation of the reference.

Explanation of Codes A-C:

(a) Kind Codes A1-A2 (and/or A-3 thru A9) will appear on Patent Applications, where a PG Publication is or was issued on or after January 2, 2001.

(b) Kind Codes B1-B2 will appear on Patents only.

(c) Kind Code B1 is used where there was NO Pre-Grant Publication issued prior to March 2001 and the Patent granted on or after January 2, 2001.

(d) Kind Code B2 is used where there WAS a Pre-Grant Publication issued prior to March 2001 and the Patent granted on or after January 2, 2001.

(e) Kind Codes C1-C3: will appear on Reexaminations only.

(f) For additional information consult: http://www.uspto.gov/patents/ebc/kindcodesum.jsp
24. Additional patent literature examples:

Example 1:

Example 2:
The Examiner relies upon the following prior art in rejecting the claims on appeal:
Horvitz US 6,182,133 B1 Jan. 30, 2001
Yamada et al. (Yamada) US 2004/0052504 A1 Mar. 18, 2004
Sengupta et al. (Sengupta) US 6,883,019 B1 Apr. 19, 2005

Example 3:

In the third column, list the publication or issue date, and abbreviate the month to three (3) letters followed by a period. Exception: Do not abbreviate the months June or July because they contain only four letters, and September is abbreviated Sept. (see T12).

For U.S. patents that qualify as prior art under 35 U.S.C. § 102(e) rather than § 102(b), list the effective filing date in parentheses in the

4 Note that the filing date is ordinarily not required unless the date is relevant to an issue in the case.
next line after the issue date only when such a date is a material fact in the case.

**Miscellaneous Opinion Formatting**

25. Line numbering for interference and reexamination decisions, although not encouraged, is at the discretion of the APJ.

26. Headings stating an opinion is not written for publication or is not binding precedent are not permitted.

27. Use footnotes judiciously and sparingly. However, footnotes are at the discretion of the APJ.

28. Adding spaces on either side of an em dash is at the discretion of the APJ.

29. Referring to the parties generically as Patent Owner and Petitioner or using their actual names is at the discretion of the panel, but the shorthand used must be consistent throughout.

**Grammar & Style**

30. Use writing styles consistent with recognized grammar reference sources, for example:

   **William Strunk, Jr. and E. B. White, Elements of Style**
   (Longman 4th ed. 1999);

   **Lynn Quitman Troyka and Douglas Hess, Quick Access Reference for Writers** (Prentice Hall 5th ed. 2007 (or 6th ed. 2010));

Commonly encountered problems include:

31. Avoid split infinitives (use “to go boldly” instead of “to boldly go”) and split verb phrases (use “the response was filed timely” instead of “the response was timely filed”)

   Tip: do a global search for “ly” and look for words in between verb phrases
   Tip: common problem words include: sufficiently, clearly, properly, specifically, reasonably, generally, explicitly, separately, previously, originally, necessarily

32. Use “that” and “which” properly
   a) “that” is defining or restrictive: The lawn mower that is broken is in the garage. (tells which one)
   b) “which” is nondefining or nonrestrictive: The lawn mower, which is broken, is in the garage. (adds a fact about the only lawn mower)
   c) See Strunk & White (words that are commonly misused)

33. Hyphenate compound adjectives (e.g., obviousness-type double patenting, well-known feature, long-felt need, etc.) A compound adjective
consists of two or more words that function as a unit and express a single thought. These one-thought modifiers are derived from (and take the place of) adjective phrases and clauses. When two or more words are combined to form a compound adjective, a hyphen is usually required. (See Strunk & White)

32. Keep words of compound verbs together (e.g., use “already has been delivered” instead of “has already been delivered”)

33. Avoid passive voice when possible (see Strunk & White Rule 14)

34. Be careful using the word “since,” it implies time – you normally will want to use “because.” By the same token, the word “while,” also implies time – you normally will want to use “although.”

35. Unless it does not make sense in context, set off by commas phrases like “therefore” and “thus” (e.g., “Reference X, therefore, teaches Y limitation”).

36. Use punctuation correctly — the most common problem is missing commas (see Strunk & White – passim).

37. Use party names consistently (e.g., “Petitioner” and “Patent Owner,” or “Microsoft” and “Apple”).

38. When in doubt, look to Strunk & White for guidance.
39. Use the serial comma, i.e., in a series of three or more terms with a single conjunction, use a comma after each term except the last (see Strunk & White Rule 2).

40. Place a comma before a conjunction introducing an independent clause.

41. Use definite, specific, concrete language, and omit needless words such as "clearly," "meaningfully," and "itself."

42. In summaries, use one tense.
Before [NAME], [NAME], and [NAME], Administrative Patent Judges.

[Last Name], Administrative Patent Judge.

[Title]

Front page of an opinion in a unanimous decision on appeal from an ex parte regular application.

A minimum of three lines of text is required for a decision to begin on the first page.

[No page number on front page]

---

1 The record includes a transcript of the oral hearing held ***.
2 According to Appellants, the real party in interest is *** (Appeal Br. *).
Before [NAME], [NAME], and [NAME], Administrative Patent Judges.

Opinion for the Board filed by Administrative Patent Judge [NAME].


[LAST NAME], Administrative Patent Judge.

[TITLE]

Front page of an opinion in a decision on appeal from an ex parte regular application, where the opinion contains a dissenting opinion.

A minimum of three lines of text is required for a decision to begin on the first page.

[No page number on front page]
Before [NAME], [NAME], and [NAME], Administrative Patent Judges.

[LAST NAME], Administrative Patent Judge, [concurring/dissenting].

First page of a concurring or dissenting opinion.

A minimum of three lines of text is required for a decision to begin on the first page.

[No page number on first page of concurring/dissenting opinion]³

³ Succeeding pages of the concurring/dissenting opinion are separately numbered (2, 3, 4, etc.).
UNITED STATES PATENT AND TRADEMARK OFFICE

BEFORE THE PATENT TRIAL AND APPEAL BOARD

Ex parte [INVENTOR(S)]

Appeal [number]
Application [number]
Patent [number]
Technology Center [number]

Before [NAME], [NAME], and [NAME], Administrative Patent Judges.

[LAST NAME], Administrative Patent Judge.

[TITLE]

Front page of an opinion in a decision on appeal in an ex parte reissue application.

A minimum of three lines of text is required for a decision to begin on the first page.

[No page number on front page]
UNITED STATES PATENT AND TRADEMARK OFFICE

BEFORE THE PATENT TRIAL AND APPEAL BOARD

Ex parte [PATENT OWNER]
Appellant

Appeal [number]
Reexamination Control [number]
Patent [number]
Technology Center [number]

Before [NAME], [NAME], and [NAME], Administrative Patent Judges.

[LAST NAME], Administrative Patent Judge.

[TITLE]

Front page of an opinion in a decision on appeal in an ex parte reexamination proceeding.

A minimum of three lines of text is required for a decision to begin on the first page.

[No page number on front page]
UNITED STATES PATENT AND TRADEMARK OFFICE

BEFORE THE PATENT TRIAL AND APPEAL BOARD

[REQUESTER]
Requester [and Appellant, Cross-Appellant, or Respondent, as appropriate]

v.

Patent of [PATENT OWNER]
Patent Owner [and Appellant, Cross-Appellant, or Respondent, as appropriate]

Appeal [number]
Reexamination Control [number]
Patent [number]
Technology Center [number]

Before [NAME], [NAME], and [NAME],
Administrative Patent Judges.

[LAST NAME], Administrative Patent Judge.

Front page of an opinion in a decision on appeal for an inter partes reexamination proceeding.

No part of the decision is placed on the front page.

[No page number on front page]
[OUTCOME]

[Judges' initials]

[initials of Paralegal only]

[MAILING ADDRESS OF APPELLANT (REEXAM CASES ONLY)]

[MAILING ADDRESS OF OTHER PARTY WHEN APPROPRIATE (REEXAM CASES ONLY)]

Last page format
BEFORE THE PATENT TRIAL AND APPEAL BOARD

[PARTY NAME],
Petitioner,

v.

[PATENT OWNER],
Patent Owner.

Case IPR or CBM [number]
Patent [number]

Before [NAME], [NAME], and [NAME], Administrative Patent Judges.

[LAST NAME], Administrative Patent Judge.

[TITLE]

Front page for an opinion in an AIA proceeding.
A minimum of three lines of text is required for a decision to begin on the
first page.

[no page number on front page]
UNITED STATES PATENT AND TRADEMARK OFFICE

BEFORE THE PATENT TRIAL AND APPEAL BOARD

[PARTY NAME],
Junior Party,
(Patents)

v.

[PARTY NAME]
Senior Party,
(Application No.)

Patent Interference [number]
(Technology Center [number])

Before [NAME], [NAME], and [NAME], Administrative Patent Judges.

[LAST NAME], Administrative Patent Judge.

[TITLE]
Front page for an opinion in an interference proceeding.
A minimum of three lines of text is required for a decision to begin on the first page.

[no page number on front page]
APPENDIX C
### Additional Microsoft Tools

I. Frequently Used Microsoft Short Cut Keys

<table>
<thead>
<tr>
<th>Symbol or Character</th>
<th>Shortcut key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nonbreaking space (Hard space)</td>
<td>Alt+Ctrl+Space</td>
</tr>
<tr>
<td>Hard dash</td>
<td>Ctrl+Shift+“dash”</td>
</tr>
<tr>
<td>Em Dash</td>
<td>Alt+Ctrl+Num- (while holding down Alt and Ctrl keys simultaneously, hit minus sign “-” on number pad)</td>
</tr>
<tr>
<td>En Dash</td>
<td>Ctrl+Num-</td>
</tr>
<tr>
<td>Right Single Quote</td>
<td>Alt+0146</td>
</tr>
<tr>
<td>Right Single Quote</td>
<td>Ctrl+“,” (while holding down Ctrl key and hit apostrophe key 2x)</td>
</tr>
<tr>
<td>Copyright</td>
<td>Alt+Ctrl+C</td>
</tr>
<tr>
<td>Registered</td>
<td>Alt+Ctrl+R</td>
</tr>
<tr>
<td>Trademark</td>
<td>Alt+Ctrl+T</td>
</tr>
<tr>
<td>Section</td>
<td>Alt+Ctrl+S</td>
</tr>
<tr>
<td>Paragraph</td>
<td>Alt+0182</td>
</tr>
<tr>
<td>Insert Endnote</td>
<td>Alt+Ctrl+D</td>
</tr>
<tr>
<td>Insert Footnote</td>
<td>Alt+Ctrl+F</td>
</tr>
<tr>
<td>Highlight</td>
<td>Alt+Ctrl+H</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Alt+Ctrl+I</td>
</tr>
<tr>
<td>Format AutoFormat</td>
<td>Alt+Ctrl+K</td>
</tr>
<tr>
<td>Insert List Number Field</td>
<td>Alt+Ctrl+L</td>
</tr>
<tr>
<td>Insert Annotation</td>
<td>Alt+Ctrl+M</td>
</tr>
<tr>
<td>View Page</td>
<td>Alt+Ctrl+P</td>
</tr>
</tbody>
</table>
Table Update AutoFormat | Alt+Ctrl+U
---|---
Edit Paste Special | Alt+Ctrl+V
Repeat Find | Alt+Ctrl+Y
Go Back | Alt+Ctrl+Z

II. Assign a shortcut key to a symbol or special character

Begin shortcut key combinations with CTRL, ALT, or a function key.

1. On the **Insert** menu, click **Symbol**.
2. Click the tab with the symbol or character you want.
   
   **Note:** If you don’t see the symbol you want, in the drop-down menus, click a different font or subset.
3. Click the symbol or character you want.
4. Click **Shortcut Key**.
5. In the **Press new shortcut key box**, press the key combination you want to use. For example, press ALT+ the desired key.
6. Look at **Currently assigned to** to see if the shortcut key combination is already assigned to a command or other item.

Reassigning a key combination means that you can no longer use the combination for its original purpose. For example, pressing CTRL+B changes selected text to bold. If you reassign CTRL+B to a new command or other item, you will not be able to bold text by pressing CTRL+B unless you restore the shortcut key assignments to their original settings.
In Microsoft Word the following letters A, B, G, J, Q, W, X as well as number keys 1-9 are not assigned to any particular character or function in conjunction with the ALT+CTRL key combination.

7. Click Assign.

III. Replacing existing straight quotes with smart quotes

Use the following method to replace existing straight quotes with smart quotes in a document.

1. To turn on smart quotes, follow these steps:
   a. On the Tools menu [you find this under the File Tab/Help/Option/Proofing] click AutoCorrect [AutoCorrect Options], and then select the AutoFormat As You Type tab.
   b. Under Replace as you type, click to select the "Straight quotes" with “smart quotes” check box, and then click OK.

2. On the Edit menu [under the Home tab], click Replace.

3. In the Find what box, type a quotation mark.

4. In the Replace with box, type a quotation mark.

5. Click Replace All.

IV. Removing Line Breaks

1. On the Edit menu [under the Home tab], click Replace.

2. In the Find what box, type ^p.

3. In the Replace with box, type a “space”.

4. Click Replace All.
In Word, a line break in the Search and Replace dialog box is specified with the combination

^p

The “p” stands for paragraph. So searching for ^p and replacing with a space will replace line breaks with spaces.